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Typographical Conventions
Listed below are the typographical conventions used in this User Guide.

• The popup menu options and the items contained in some applications are 
listed in bullet and use the bold, italic letters; for example, • All received 
calls: Block all incoming calls; • Bookmarks: Selects to choose a website.

• The text enclosed in brackets indicate that it is the name of the menu option 
we need to select in the process of operating; for example, select 
[Applications] in [Preferences]; select [Share], and then select [Via 
Bluetooth].

• The application name is input in capitalization; for example, using the 
Phonebook application, access the Phonebook application, access the 
Pictures application. 

• When the application name is used as a common noun, it is input in 
lowercase characters; for example, in the pictures list.

• The menu item uses the capitalization that is used in Smartphone system; for 
example, to open the Options menu.
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Getting started

When you work through the instruction in this User Guide, you will 
need all the components that came in the Smartphone box as well as 
the following:

• A SIM (Subscriber Identity Module) card
• A location with wireless coverage for your Smartphone
• An electrical outlet

When you get the Smartphone, you should have all the following 
components inside the Smartphone box:

• Handset         ·Handsfree earpiece
• Battery                  ·User Guide
•Travel charger             ·Warranty card

What you will need

Components inside the box
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1. Status indicator                               7. End call key
2. Left function key                             8. Numeric keypad
3. Call key                                         9. Camera flash
4. Earpiece                                         10. Speaker
5. 5-way navigation key                      11. Camera 
6. Right function key                         12. Mirror

Smartphone overview
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13.  Camera/Capture button       19. Power on/off button

14/15. Volume button      20. Earphone jack

16. Expansion card slot  21. Universal port      

17/18. Strap hole    22. Microphone

     

     

    

Left Right
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To remove the battery
1. Press and hold the power button to turn off Smartphone. (See 

page21 for “Switching on your Smartphone”)
2. Remove the battery cover by sliding it downwards.
3. Gently lift the lower edge of the battery outwards; take out the 

battery.

Installing and removing battery



14

G
ettin

g
 started
To install the battery
1. Place the battery with the metal contact facing downwards in the 

battery compartment, press the battery downwards until it fits 
into the battery compartment.

2. Slide the battery cover upwards to close the cover.
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To charge the battery
1. Connect your charger to the Universal port (as below).

2. Plug the charger to the main electrical outlet.

3. Charge the battery for about 12 hours before first use. The 
approximate charging time after the first charge is around 2 
hours. (Approximate charging time depends upon battery 
usage.)

Battery use and care
A. We recommend that you fully charge the battery before you use 

your Smartphone for the first time.
B. A new battery or one which has not been used for a long time 

may have reduced capacity for the first few times it is used.

Charging the battery
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C. It is important that you always turn off your Smartphone before 
removing the battery. Failure to do so can cause corruption of 
data memory.

D. Always detach the charger before inserting or removing the 
battery.

E. Warning! Battery may explode if disposed of in fire.
F. Do not expose the battery to liquid.
G. Do not disassemble or modify the battery. Only use the battery 

for its intended purpose.
H. Do not let the metal contacts on the battery touch other metal 

objects as it could lead to short-circuit and/or damage the battery.
I. Keep the battery out of the reach of children.
J. Do not put the battery into your mouth, the battery electrolytes 

may be toxic if swallowed.
K. To maximize the performance of the Smartphone and not void 

the warranty, always purchase the accessories that are specially 
designed for use with the Smartphone. Customer Service cannot 
be held liable for any damage due to use with non-authorized 
accessories.

L. Talk time and standby time depend on actual transmission 
conditions. If the Smartphone is used near a base station, less 
power is required. Talk and standby time will therefore be longer.
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When you register as a subscriber with a network service provider, 
you will get a SIM (Subscribe Identity Module) card. The SIM card 
contains a computer chip that holds your Smartphone number, etc.

Before using mobile networking features, (e.g., making/receiving 
calls, sending messages) you need to install a SIM card first.

To install SIM card
1. Remove the battery first, insert the SIM card with the golden 

connector facing down as illustrated below.
2. Push the SIM card sideways.

SIM card
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To remove SIM card
1. Push the SIM card sideways to remove the card as illustrated 

below:

Note: Please be careful not to bend or scratch the SIM card. Do not 
expose the card to liquid or static electricity!
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You can use a mini expansion card with more than 1 GB memory in 
your Smartphone to expand data storage. You can use the expansion 
card to save photos or other files.

To install expansion card
1. Open the cover on the side of your Smartphone; insert the card 

with the metal contact facing upwards into the card slot as 
illustrated below.

2. Close the cover.

Installing and removing expansion card
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To remove expansion card
1. Open the cover.
2. Press the inserted card to release and then remove card.
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Switching on your Smartphone 
Your Smartphone is designed to be turned on without a mobile 
network connection.

To switch on your Smartphone
1. Press and hold the power button  to switch on your 

Smartphone.

2. Enter your PIN (Personal Identification Number) if you have 
one for your SIM card. Your network operator provides the 
PIN.

Note: If you make a mistake while inputting the PIN, press the  
button to delete the wrong number. If you enter the wrong PIN 
three times, you need to input the PUK (Personal Unblocking 
Key) which is also provided by your network service provider.

3. After successfully entering your PIN, your Smartphone will 
search for an available GSM network. You can make and 
receive calls when the network operator’s name and signal 
strength icons appear in the screen. (See page26 for signal 
strength icon.)

4. Press and hold the power button  to turn off Smartphone.

Switching on your Smartphone



22

G
ettin

g
 started
Before making a call, make sure you are within range of a mobile 
network.

To make a call
1. Switch on your Smartphone.

2. Allow the Smartphone to complete a network search, it may 
take a few seconds. Once complete, the signal strength icons 
appear on the screen.

3. Input the PIN number if need.

4. Enter the number you wish to call. Press and hold “*” to 
enter “+”; “0” to enter “P”.

5. Press  to correct any mistakes.

6. Press  to dial. 

7. When your call is complete, press  to hang up.

Making calls
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Getting to know your 
Smartphone

Main menu overview
In the idle screen, press  to access main menu. 

In the main menu, use the 5-way navigation key to switch between 
applications. Press  to select the desired application.

Applications overview
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1. Phonebook                       2. Messaging*   

3. PIM

Calendar         Calculator        Notes  

4. Camera       

5. Media 

What’s New    Music    Pictures    Video

6. Preferences

Call Forward           Profiles                       Voice Calls*

Networks Phone Settings            Security

Set Clock Connectivity               Applications 

    Advanced settings        Call Costs (Network Dependent) 

7. Utilities   

About                   Application Manager        Content Manager     

    Sync                     System Manager               World Clock 

    Backup

8. Email*   

9. My Applications      10. Web*  11. Call Log  

12. Chat*
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Note: All items with “*” need the support of your network service 
provider. Please contact your network service provider for 
details.

Viewing options in idle screen
In the idle screen, press  to open the Options menu, press  /  
to select the appropriate option, and then press  to accept it.

• Lock: Locks the keypad. 
• Profile: Provides a submenu containing all profiles available on 

the phone.  Select one of these options to set the current profile. 
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• Active Apps: Checks the applications that are being used.
• Bluetooth: Turns Bluetooth on and off. 
• Call Log: Accesses call records list. 
• Voicemail: Dials the user’s voicemail. 
• Customise: Creates a personal idle screen manually. 
• Flight Mode: Selects to turn flight mode on and off.
• More: Provides a submenu with options to set the idle screen or 

to display help information. 

Status bar
The Status Bar is located at the top of the screen, and displays the 
following status:
Icon Indicates

The strength of mobile network signal

GPRS available

GPRS connected

Network connection active
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Battery level

Battery charging status

Handset radio turned off

Bluetooth networking on

Phone active as modem

Phone profile

Secure connection active

User notification

Text input modes (Press and hold  to switch input
mode)
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The idle screen is displayed when you are not using the menu or 
making calls. You can see the network operator’s name, the date and 
the time.

Keys Instruction:

Keys and navigation

Key Actions

Accesses the main menu from the Smartphone 
idle screen.

Selects the options shown above the key on the 
screen.

Selects the options shown above the key on the 
screen.

    Navigates through the menus and tabs.

In the idle screen, press to view call records in call 
log; press and hold to make a voice call.

Makes/answers a call.

Returns to idle screen no matter which application 
you are in.
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Navigating the screen
You can navigate the screen using the 5-way navigation key.

You can scroll on the Smartphone to move from field to field, page to 
page or highlight an item. There are several ways to scroll. 

Ends/rejects a call.

Returns to previous page.

 - In the idle screen, press and hold any of these keys 
to speed dial. (Make sure you have set the speed 
dial number.)

Activates the camera, press it again to take a 
photo.

Increases volume.

Decreases volume.

1. Up
2. Left
3. Down
4. Right
5. Enter
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• Press  /  /  /  of the 5-way navigation key to move to the 
next field, button or action in that direction.

• When viewing a list screen, (e.g., a message):
– Press  or  to scroll the screen.
– Press Enter and then press  or  to scroll between line 

items.
• When inside a text field, press  or  to reselect the character or 

word, and edit again.

Locking the keypad
To avoid dialing a number by accident, you can lock the keypad.

To lock the keypad

1. In the idle screen, press  and select [Lock] to lock the keypad.

2. Press , then press  to unlock the keypad.

To set the automatic keylock
Automatic keylock locks the keypad a short while after you last press 
a key.

• Select [Preferences]  [Phone Settings]  [Display]  
[Autolock]  [On].



  
G

et
ti

n
g

 t
o

 k
n

o
w

 y
o

u
r 

S
m

ar
tp

h
o

n
e

31
Sending and receiving data via Bluetooth
Your Smartphone has built-in Bluetooth functionality through which 
you can send data.

To send data via Bluetooth
1. First enable Bluetooth. Select [Preferences]  [Connectivity]  

[Bluetooth]  [Turn on].
2. Select the item you want to send, and then select Bluetooth as 

transfer method.
3. Once the available receivers are displayed, select the receiver you 

want to send the item to.

Note: If the list of available Bluetooth devices is empty, Smartphone 
will search for a device automatically.

4. The “Connecting / Sending...” message is displayed on screen.

To receive data via Bluetooth
• A message from the sender is displayed on the receiver’s 

Smartphone, press  to receive it, press  to discard the 
received item.

Sending and receiving data 
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Entering letters
There are several ways for you to enter letters when you add names to 
your phonebook, write messages, etc.

• Multitap text input (Abc input methods)
Press each key as many times as needed to show the letter you 
want.

• text input
This input method uses a built-in dictionary to recognize the most 
frequently used words. You press each key only once, even if the 
letter you want is not the first letter on the key.   

Selecting input methods
In a text edit field, press and hold to select the input methods.

Input methods

T9TM 
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Multitap text input methods
To use Multitap text input methods

1. Scroll to Message, write a new message.

2. Press and hold to select the Abc input method.

3. Press  to select ABC, Abc or abc.

4. Press each key as many times as needed to show the letter you 
want, press to accept the letter and add a space here.

Note: When using Multitap text input methods, press   to input 
the punctuation.

See the table below:

Press to get...

. , - ? ! ’ @ : 1

ABC2

DEF3

GHI4
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Example:

• To enter an “A”, press once.
• To enter a “B”, quickly press twice.

JKL5

MNO6

PQRS7

TUV8

WXYZ9

Press to input “0” in Number input mode

Press to input the punctuation

Press and hold to select input method
Press to select ABC, Abc and abc

-
Press and hold to input number
Press to input English letter

Press to get...
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Text input
To enter letters using text input

1. Scroll to Message, write a new message.

2. Press and hold to select the Abc input method.

3. Press  to select ABC, Abc and abc.

4. For example, if you want to write the word “Thank”, press 
“8+4+2+6+5”.

5. If the word shown is the one you want, press  to accept the 
word; the word is not the one you want, press  /  to check 
the candidate words. If the word you need is not in the 
candidate words, press  /  to edit the word yourself until 
no any other words for you to select.

6. Continue writing your message. Press  to enter other 
punctuation marks, press  to accept.

Note: Press and hold  to switch the input method; press  
to select the punctuation.

T9TM
 

T9TM 

T9TM 

T9TM T9TM T9TM 
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Chinese input
Your Smartphone has two input methods for entering Chinese 
characters: Stroke and Pinyin input.

General instructions
Regardless of which input method you choose, your Smartphone can 
speed the entry of Chinese characters. When you enter a Stroke or a 
Pinyin letter, a candidate row of the frequently used characters 
including the Stroke or relating to that letter appears at the bottom of 
the input area.

If the character you want is not in the candidate row, press to present 
another candidate row, continue pressing  until the character you 
want is displayed. Alternatively, enter the next Stroke or Pinyin letter, 
and a new set of candidate row is displayed. Press  to go back to the 
previous row, and then press  to accept a word.

Stroke input methods
A Chinese character is built up of strokes. There are more than 30 
basic strokes that are grouped into 5 stroke categories. Each category 
is presented by one of the keys  - , the wild key , is used 
when you are not sure which stroke to use.

T9TM
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Stroke input
1. Press and hold to select Chinese input.

2. Press  to switch to Stroke input.
Stroke categories:

Number 
Key

Stroke 
Category

Basic 
Stroke Stroke Name Example

Over 王十在七天

Lift 海紅牡狀習

Down 中葉上門醜

Down-Hook 小水打子承

Short Slope Down 直真質草

Long Left Slope 八九丹風片

Over Slope 香千匕後丟

Short Left Slope 而頁面學殷

Dot 六學雷心性

Right Slope 人火又送林

Down-Curved-Over 四西酉酸
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Down-Over 由巨屯母凶

Left Slope-Over 麽去公約能

Left Slope-Dot 女要好巡巢

Down-Lift 衣以飯收長

Right Slope-Hook 我或民成伐

Down-Over-Hook 心必思忘

Down-Over-
Curved-Hook

電也毛兄孔

Down-Over-Down-
Hook

馬與張號費

Down-Over-Down 鼎鼐

Number 
Key

Stroke 
Category

Basic 
Stroke Stroke Name Example
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Over-Hook 寫字皮通兔

Over-Down 口已戶書骨

Over-Down-Hook 力習也同永

Over-Left Slope 又之登多社

Over-Down-Over-
Left Slope

及極廷建

Over-Left Slope-
Curved-Hook

阿隊陳那部

Over-Down-Over-
Hook

乃透鼐雋楊

Over-Down-Over-
Down

凸

Curved-Hook 狗豹家逐狂

Over-Down-
Curved-Hook

乙九瓦飛風

Over-Down-Over 投沿船凹

Number 
Key

Stroke 
Category

Basic 
Stroke Stroke Name Example
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Pinyin input method
Press the keys containing the required Pinyin letters, and your 
Smartphone can make the various proposals on the screen according 
to the pronunciation rules of the Mandarin dialect.

See the Pinyin letters on the keypad:

? (Wild card key) It is used when you are not sure
which stroke to use 

Number Key Pinyin Letter Number Key Pinyin Letter
abc pqrs

def tuv

ghi wxyz

jkl

mno

Number 
Key

Stroke 
Category

Basic 
Stroke Stroke Name Example
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To enter Chinese characters using  text input

1. Press and hold to select Chinese input.

2. Press  to switch to Pinyin input. 
3. For example, if you want to enter [語言], press “9+8”, when [yu] 

is highlighted, press / to check the candidate word and select    
[ 語 ], then press  to select it. (If you want to enter any other 
suggested Pinyin combinations, press / scroll to the desired 
combination, press .)

4. Press the navigation key again to select [ 言 ].

Punctuation
In Chinese input, press  to display the punctuation list, press the 
navigation key to select the desired one, press  to add a space.

123 Number input
Press and hold  to switch input mode and select Number input. 
When in Number input method, you can only input the numbers from 
the keypad  - .

T9TM 
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Phone

Before using the phone function, make sure that you have switched 
on your Smartphone and you are within range of a mobile network.

Making a call
When you switch on your Smartphone, it searches for a network 
automatically. Once network service is available, you can make or 
receive calls.

Note: You can make calls from the idle screen, or you can also make 
a call in Speed Dial or Call Log. 

To make a call from the idle screen
1. In the idle screen, enter the phone number (with International 

country code and area code if necessary).
2. Press  to make the call.

Using the phone function
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3. Press  to end the call.

Options in Dial Number screen

• Press , select [Insert Pause] from the popup menu to insert a 
pause displayed as P into the number. Press  to delete the 
wrong number.
– Add to Person: Open the phonebook edit screen, add the 

number to phonebook.
– Send Message: Send message to the current contact.
– Block ID: Block (Unblock) the Caller ID from being sent on 

the current call. The block icon is displayed on the screen.
– Dial From: Select to dial from phonebook, SIM phonebook or 

call log.
– Help: Display Help.
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To make a call in Speed Dial
To add contacts in Speed Dial

1. In the main menu, select [Preferences] [Voice Calls] [Speed 
Dials].

2. Select the position you want to set the speed dial number from 2-
9 for the speed dial feature. Press  to input the number 
directly, or press  to select [Browse] in the number input 
screen, and select the number from the phonebook.

To make a call in Speed Dial

1. In the idle screen, press and hold any key of  -  to call 
the contact, or select the number you want to dial out, then press 

.

2. In the idle screen, press and hold to dial the voice mail 
number.

To make a call via Voice Tag
In the idle screen, press and hold , when prompts, say the voice 
tag you have recorded. Dial the number when the voice tag is 
recognized.
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Receiving an incoming call
When you receive a call, the phone rings and the caller’s name and 
number are displayed (if they are identified). If the number is in your 
phonebook, the name, number, and pictures (if assigned) are 
displayed.

• Press  to answer the call.

• Press  to reject / end the call.
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Sending a picture or other file

During conversation, press  to select [Send Pic] tab, press  to 
capture the picture and send it. Press  [Pictures] to select the 
captured picture, or choose an existing picture from the ones stored 
on Smartphone.

Press  again to select [Send Other]. Select a file you want to send to 
the person you are talking to. 

If the person on the other end of the call has no mobile number or 
email address, or an incoming call is received without Caller ID, you 
can see a Send To screen that tells them the picture cannot be sent to 
the default address, and asks for an address.

After hanging up the call, the phone will send out the file that you 
have selected during the conversation.
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More than one call
You can handle more than one call simultaneously.

To make a second call

1. If you already have a call, press  and select [Hold].

2. Enter the number you want to dial. 

3. Press  to dial, press  select [Swap Hold] to switch the 
parties.

Conference calls
In a conference call, you can have a conversation with a number of  
people. Also, you can hold the conference and make another call.
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To add a new participant

1. Press  and select [Add Party] in the popup menu.

2. Enter the number to call the next person you want to include in 
the conference call.

3. If you have held the call, press  and select [Add held to 
conference], to add the held party to conference.

To remove a participant 

• Press  and select [Remove] to hang up the selected participant 
in the conference call.

To make a private conversation

• Press  and select [Private] to hold the conference call, and 
have a private conversation with the selected participant.

To view the person details

• Press  and select [View Person], open the phonebook 
application to view details about the selected person. This 
selection is disabled if the selected number is not in the 
phonebook. 
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Call management
In phone settings, you can use the following functions: Call forward, 
Call waiting, Fixed dialing and Call barring.

Call forward
If you cannot answer incoming calls, you can forward them to 
another number here.

Select [Call Forward] in [Preferences] to access the Call Forward.

You can use the following forwarding functions:

• Forward all calls: Forwards all calls to another number or 
voicemail.

• Forward if busy: Forwards when you are busy.
• Forward if unanswered: Forwards when you cannot answer the 

phone.
• Forward if unreachable: Forwards when your phone is turned 

off.
• Turn off all forwards: Turns off all forward calls.

To activate a call forward
1. In the main menu, select [Call Forward] in [Preferences].
2. Select one of the forwarding options ([Forward all calls],   

[Turn on]  [Send to Number]) and enter the phone number to 
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that you want your calls to be forwarded. You can also select  
[Send to Voicemail].

To deactivate a call forward
• Scroll the call forward option you want to turn off. Select [Turn 

off] to deactivate.

Call waiting
In the main menu, select [Preferences] [Voice Calls]  [Call 
Waiting] to turn on/off this function. (This function requires the 
support of your network service provider.)

Call barring
You can use call barring to restrict outgoing calls and incoming calls, 
you need a password that you get from your network service provider.

Select [Preferences] [Voice Calls]  [Call Barring].

A list of call barring options is displayed:

• All received calls: Block all incoming calls.
• Received abroad: Block all incoming calls while you are abroad.
• All calls out: Block all outgoing calls.
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• International calls out: Block all outgoing international calls.
• International but home: Block all outgoing international calls, 

except those to your home country.

Call barring setting
1. Before accessing the call barring, you need enter the call barring 

code (Contact your network service provider for more 
information).

2. Select one from the above options and press . Press  to 
activate the selected option, otherwise, press  to turn it off.

Fixed dialing
The fixed dialing function allows users to edit the fixed dialing 
numbers that are saved on SIM card. Fixed numbers are protected by 
PIN2.

Partial numbers can be saved. For example, saving 978856 allows 
dialing all numbers that starts with 978856.

Once you turn on the fixed dialing function, you cannot check any 
records saved on SIM card, and cannot dial any numbers that are not 
saved in fixed dialing list.
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Note: You can still make an emergency call, even when the fixed 
dialing function is enabled.

To activate or deactivate fixed dialing
1. Select [Preferences] [Voice Calls] [Fixed Dialing] [Fixed 

Dialing] [Yes] to activate, or select [No] to deactivate.
2. Enter your PIN2.

To save a fixed dialing number
1. In the Fixed Dialing Numbers screen, select [Fixed Dialing]  

[Fixed Dialing Numbers], press  to add a new number.

2. Input the phone number, and the name of the contact. Press  
to save it, enter the PIN2.

To make a call in fixed dialing

• In the fixed dialing list, select a number, press  to select 

[Call], or press  to dial the number.
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Call log
There are four call log categories: Dialed calls, Received calls, 
Missed calls, and All calls. Numbers of the most recent calls are listed 
in call log.

To access the call log

1. In the main menu, select Call Log icon  to access. Or press 
 to access the Call Log in the idle screen.

2. Press  to select the log category to view.

To call a number from call log
1. Scroll to the number you want to dial.

2. Press  to select [Call] or press  to dial out directly.

To add numbers from call log to phonebook
1. Press  /  to scroll to the number you want to add.

2. Press , and then select [Add to Person] to create a new entry, 
or to select a person to add the number to.

To send a message from call log
1. Press  /  to scroll to the number you want to send message to.

2. Press , and then select [Send Message], open the message 
application with “To” filled with the selected number.



54

P
h

o
n

e

Emergency call
Your Smartphone supports emergency call, such as 112. You can 
make an emergency call in any region with or without SIM card, if a 
GSM network is within range.
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Messaging
Your Smartphone supports various messaging services: SMS (Short 
Message Service), MMS (Multimedia Messaging Service), Email and 
Cell broadcasting, etc.

Note: All messaging services must be supported by your network 
service provider. MMS and Email need special setting service, 
please contact your network service provider for details.

To open the Messaging application

• In the main menu, select Messaging  to access all of the 
messages you have received.

• Press  to select [Mailboxes], it contains Inbox (SMS, MMS, 
SIM, WAP service), Outbox, Drafts and Sent.

Accessing the Messaging application



56

M
essag

in
g

A brief introduction to composing new messages
There are several ways to compose a new message:

• In the Inbox, press  to access the composing screen directly.

• Or in the Mailboxes, press  to access the composing screen 
directly.

• Or in the Mailboxes, select the desired application (e.g., SMS), 
press  to compose a new message.

• You may also compose a new message in the Sent folder.
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Adding a new mailbox
To manage messages easily, you can create several multiple 
mailboxes as you like.

To add a new mailbox

1. In the Mailboxes, press  to select [Mailbox]  [New].

2. Enter a name for the new mailbox, press  to confirm your 
entry and return to mailboxes screen. When you go back to the 
mailboxes screen, you see the new mailbox that you have created. 
(You can delete or edit each mailbox.)

Managing information
To move messages

• In the Inbox, select a message, press  to select [Message]  
[Move To]/[Move All To], move the selected message or all 
messages to Outbox/Drafts.

To mark a selected message as read/unread

• In the Inbox, select a message, press  to select [Message]  
[Mark as Unread], mark the selected message as an unread 
message.
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To delete messages

• Press  to select [Message]  [Delete]/[Delete All], press  
to delete either a selected message or all messages. 

To reply/forward messages

1. Press  to select [Compose]  [Reply]/[Reply All]/[Forward], 
to reply or forward message.

2. In message view mode, press  to reply the message.

In the Messaging application, you can compose SMS, MMS 
messages.

You can send a message to more than one person, or send to a group 
(The contacts saved in phonebook). when composing messages, you 
can add picture, music, video or other files and send them to your 
contacts.

Composing and sending messages
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Composing a new message
To enter numbers

1. You can access the composing screen in the ways mentioned on 
Page57.

2. Enter numbers in the message box. Or press  to select 
[Phonebook], select a number in the phonebook, and then press 

 to select [Done], the selected number is shown in  [To].
You can send  message to more than one person.

3. Press  to select [Sub] and input the subject.
4. Select the text field and input the text contents. 

(You can input various options in the content).

5. Press  to send the message when finish.

To add a new item
1. Press  to select [Add Item].
2. Insert picture, video, audio, event or other files into the message.

Items option
• If you have added a new item option, select this item and press 

 to select [Item Options]  [Remove Item], delete the 
selected item.
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New page

• When composing a message, press  to select [Page Options] 
 [New Page] for adding a blank page. If you want to delete the 

new page,  select [Page Options]  [Delete Page].

Advanced options
1. When composing a message, press  to select [Advanced 

Options], press  to select [Send  Anonymously] and send 
message anonymously.

2. Select [Set Priority] to set the priority of the message.
3. Select [Background color] to set the color of the message page. 
4. Select [Save As Template] to save the message as a template.

To save as draft
• If you do not want to send the message now, select [Save As 

Draft] to save the message in the Drafts for sending later.
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Managing recipients 
When composing a new message that you want to send to a group of 
people or more than one recipient, you can manage this in [Manage 
Recipients].

To manage recipients
1. In the message edit screen, press  and select [Recipients] to 

access the Manage Recipients screen.
2. Press  and select [Add To]  [From Phonebook]; select a 

contact and add it to Recipient. Alternatively, select [Add To]  
[Other Person] to enter a recipient’s number/address manually.

3. Press  and select [Add CC]  [From Phonebook]/[Other 
Person] to make a copy to another recipient.

4. Press  and select [Add BCC]  [From Phonebook]/[Other 
Person] to make a blind copy to another recipient.

5. Press  to continue when finish.
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Sending a message
The message can be sent as:

• If the message is entirely text, and does not exceed the maximum 
length for sending an SMS (less than 100 characters), it should be 
sent as an SMS.

• If the message contains any non-text content, it should be sent as 
an MMS.

• If the recipient address is an email address, even if the message is 
entirely text, it should be sent as an MMS.
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Receiving and reading messages
When you receive a message, the system gives prompts to forward or 
reply to the message.

When the message is an SMS
• In the prompt screen, press  to open the Option menu, select 

[More options] to read the message directly.
• Or, select an unread message in the Inbox to read it.

To dial a number

• Press  and select [Call]. If the message contains a phone 
number, you can select the number and press  to dial.
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To add to phonebook
• If the number you received does not exist in the phonebook, press 

 to select [Add to Phonebook] and save the number.

To save as template
• You can save the current message as your message template.

To delete a message
• Select [Delete Message] to delete the message you are reading.

To reply a message

• In message view mode, press  to reply to the message.

When the message is an MMS
• In the prompt screen, press  to read the message or press  

to read it later.
• Select an unread message in the Inbox to read it.

If the received message contains an attachment, press   in view 
mode to select [View Attachments]. Then select the attachment you 
need to save, and press  to select [Save].
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Template
You can save a message as your MMS template.

To save the received message as a template

• In message view mode, press  to select [Save As Template] to 
set the message as a message template.

To compose a new message from a template

• In the Inbox, press  to select [Compose]  [New From 
Template] or in the Mailboxes, press  to select [New From 
Template] to access the message template screen. Then press  
to compose a new message.

Messaging settings
You must complete your messaging settings before using Messaging 
application.

• In the main menu, select [Preferences]   [Advanced Settings] 
 [Messaging] to set the following options:
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Save Sent Messages
• Turn it on to save the messages that you have sent in mailbox 

automatically.

Cell Broadcast
Please contact your network service provider to find out if you can 
use this service, and what kind of channel you can use. (Please make 
sure that the network is available before using Cell Broadcast. )

In messaging settings, select [Cell Broadcast]  [Channels], then 
select [All] and check All to register all channels. Alternatively, 
follow the instructions on screen and press  to set it. (If you turn 
off the Reception function, you will not be able to set the channels)

• Area Info: Press  to display the area information.
• Reception: Turn reception of cell broadcast messages on or off.
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• Alert: Select to alert when a cell broadcast message arrives.
• Automatic: Select to receive and display cell broadcast messages 

automatically.
• Language: Choose which language you want to use for cell 

broadcast messages.

SMS
• SMSC: Enter the SMSC (Short Message Service Center) phone 

number. and press  to set the number. You can get this 
information from your network service provider.

• Access Type: Choose the transport method for SMS: GSM or 
GPRS.

• Reply path: Press  to use the SMSC specified in the message 
for the reply path.

• Validity period: Set the validity period for new SMS messages.

MMS

• MMSC List: If there are no records in the list, press  to add a 
new IP address. Press  to save the setting. (MMSC: 
Multimedia Messaging Service Center)

• Connection: Select the account to use for MMS. If no accounts 
are shown, you can create and edit accounts in the GPRS and 
GSM dialup connection settings menu.

• Protocol: Choose WAP to use WAP transport for MMS. Choose 
Internet to use HTTP transport.



68

M
essag

in
g

• Defer when Roaming: Choose [Yes] to prevent MMS receipt 
while roaming. You can pick up messages when you are in your 
home network.

• Request Delivery: Choose [Yes] to receive MMS delivery 
confirmation. Choose [No] if you do not want to receive 
confirmation requests.

• Request Read Report: Choose [Yes] to receive MMS read 
confirmation. Choose [No] if you do not want to receive.

• Validity Period: Select a time to retry sending an MMS message. 
Use delivery report if you need to confirm delivery.

• Max Message Size: Enter maximum message size in KB for 
sending and receiving MMS.

• Automatic Download: Choose [Yes] to automatically receive 
MMS messages when they are available.

• Return Delivery: Choose [Yes] to return delivery report to sender 
on request; otherwise, choose [No].

• Return Read Report: Choose [Yes] to return read report to 
sender on request; otherwise, choose [No]. 
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You can use your Smartphone to send and receive email messages. 
Attachments on incoming messages can be saved onto your 
Smartphone. You can also attach files to outgoing messages. Your 
Smartphone supports POP3 and IMAP service.

Note: You need a subscription that support data transmission, 
please contact your network service provider for details.

Email settings
Before using this application, you need to set up all email account.

Note: When you purchase the Smartphone, the email settings may 
already be entered. If not, you can contact your network ser-
vice provider for details. Some network service providers may 
provide a special service that you can request the settings in a 
message. You can also set up an email account manually.

Email
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To set the email account manually
1. In the main menu, select [Email]  [Email Settings]  [Email 

Address] to enter an email address as your “From” address.
2. Select [Outgoing Mail Server] and enter the name of the outgoing 

mail server, e.g., smtp.example.com. 
3. Select [Server Type] and specify whether your incoming mail 

server uses POP3 or IMAP.
4. Select [Incoming Mail Server] and enter the name of the 

incoming mail server, e.g., pop.example.com. 
5. Select [Leave Mail on Server] and retain a copy of the email so 

you can access the mail by another email client.
6. Select [Maximum Incoming mail] and then select the maximum 

size for incoming mail.
7. Select [Include Orig Msg] and turn on to include the original 

message in your reply.
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Composing and sending email messages
To compose and send an email message

1. In the main menu, select Email  to access the Email 
application.

2. Press  to select [Compose].
3. Enter the recipient’s address in [To], then select [Sub] to input the 

email subject.
4. Select the text field to input the content. You can attach files in 

the email; press  to select [Attachments]  [Add] and select 
the file you need.

5. Press  to send the email when you have finished composing. 
Or, if you wish to send the email later, press  to select [Save 
as Draft] and save it in the Drafts.
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Note: If you do not set up your email account, you will not be able 
to  compose email messages. Please contact your network ser-
vice provider for details.

Receiving and reading email messages
To receive and read an email message

• When accessing the Email application, press  to receive new 
email messages.

• In the Inbox, select an email message to read it.
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To save an email message

• In the Inbox, press  to select [Save Email] and save the email 
in the Saved.

To save attachments

• If the email message contains attachment, press  to select 
[Save]  [Attachments] and save the attachments onto your 
Smartphone.

Note: The number of the email messages that can be saved depends 
on the memory in your Smartphone.  All incoming email mes-
sages are saved to your Smartphone. 

Replying and forwarding email messages
Select an email message in the Inbox, or in message view mode, press 

 to select [Reply]/[Forward] and access edit mode.

Deleting email messages
Select an email message in the Inbox, or in message view mode, press 

 to select [Delete]/[Delete All] and press  to delete the 
selected message(s).
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Your Smartphone has a WAP (Wireless Application Protocol) 
browser that is designed for Internet browsing on your Smartphone. 
This enables you to access various services, such as, news, 
entertainment, games, etc. If this is your first time to connect WAP, 
you must contact your network service provider for details.

Accessing the Web application
To open the Web application

1. In the main menu, select [Web]  to access the Web application. 
(If no network is available, please contact your network service 
provider for details)

Web
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2. Select a website to browse.
3. Select [Exit] to go back to the Web screen.

Options when browsing
To browse the options in Web

• In the Web screen, press  to check the different options:
• Bookmarks: Selects to choose a website.
• Add To Bookmarks: Adds the current website to bookmarks.
• Open Page: Enters the website location.
• Home: Returns to your home page.
• History: Allows you to view a list of the websites you have 

visited.
• Save/View Items: Saves the selected items in the website.
• Save this Page: Saves the current website to the selected folder.
• More: Displays the advanced settings.

– Search in Page: Enters the characters to search in the website.
– Privacy:

Clear Cache: Selects to clear Cache.
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Clear Cookies: Clears Cookies list.

Clear History: Clears the list of websites that you have 
browsed.

• Exit: Exits to the main menu.

Web settings
You must set the browser before accessing this Internet. You may 
contact your network service provider for details. Please note both 
Network setting and browser basic settings need to be set. (Before 
using Web, you may need to adjust the Web Internet settings, see 
page139)

Web settings

1. In Web main screen, press  to select [More].
2. Select [Settings] to set the followings:
• Multimedia

– Images: Selects to show images.
– Sounds: Selects to play sounds.
– Objects: Selects to download objects.
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• Look and feel
– Homepage: To change the homepage, you can navigate to a 

site, and choose Set homepage from options menu.
– Font size: Sets the default font size for the browser.
– Text wrap: Allows you to choose to wrap text within a word or 

only at the end of a word.
– Text entry: Sets the time delay before advancing to next 

character.
– Scroll step: Sets the scroll step between lines or pages.
– Circuit prompt: Sets to prompt for confirmation in opening 

circuit switched connections.
– Connection time out: Sets the maximum connection time 

allowed for web response. Before the application stops, trying 
to connect.

• Security settings
– Secure prompt: Warning before entering non-secure site.
– ID cache: Caching the user ID and password.
– Cookies: Allows Cookies.
– Link referral: Selects to allow current site to view previous 

URL.
• Certificates:

– When you buy the Smartphone, it may contain the certification 
information.
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• Advanced
– Title region: Selects to show phone’s title while browsing.
– Content push: Selects to allow content pushes from the 

network.
– Mobile identification: Selects to transmit mobile ID on GSM 

networks.
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PIM

You can save your phonebook information in your Smartphone. You 
can also dial out or send messages in the Phonebook application. The 
phonebook database includes several shared system groupware, 
through which you can contact your friends using Chat application.

You can also add ringtones and information such as email addresses 
and voice tags to your contacts. If you have categorized your 
contacts, it is easy for you to check the contact information.

Using the Phonebook application
In the main menu, select [Phonebook]  to access the Phonebook 
application, and all records are displayed in the contact list.

Phonebook
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To create a new entry

1. Select [Phonebook]  press   [New Person].
2. Input the name and phone number.
3. Select [Ringtone] to access the Ringtone and select a sound or 

video; press  to preview the video (See page116).

4. Select [Picture] to add a picture for your contact. Press  to 
access camera to capture a new picture (See page99).

Note: If you have added pictures, a ringtone or video for a contact, 
the picture or video is displayed when you receive an incoming 
call from this contact. (The Caller ID function can only be 
used with the support of your registered network service pro-
vider.)

5. Press  to save the entry when you finish editing.
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When editing the contact information, you can also add an email 
address, fax number, birthday date or categorize the record.

To add a field for a contact

1. In Edit mode, press   [Add Field].
2. Select the field you want to add for the contact, (e.g., [Fax]) and 

then go back to Edit mode and enter the fax number.

To delete a field
1. In Edit mode, select the field you want to delete.

2. Press  and select [Delete Field].
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1. In Edit mode, press   [Add Field]  [Category].

2. Press   [New] to create a personal category.

3. Select the category the contact belongs to and press .

To set a phone number as a speed dial number

1. In Edit mode, select a number field and press   [Speed 
Dial].

2. Select a field in position 1-9 (e.g., “5”); press for the selected 
number to be set as a speed dial number (Marked with a tag). 
Press and hold  to dial out in the phone idle screen.

Creating a new list
You can create a group list of contacts to easily send a message to 
several recipients simultaneously.

To create a new list

1. Select [Phonebook],  press  to select [New List].

2. Enter a name for the new list and press  to access the new list.
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3. Press  to select [Add Person] , choose contacts in the contact 
list and add to the new list.

To send messages via group list
1. In the contact list, select a contact or a group list. Alternatively, in 

a new group list, press  to select [New Message]/[Send List 
Message] to access the message edit screen and the selected 
contact appears as the recipient.

2. Edit the message and press  to send the message.                
(See page58)

To dial from group list
1. In the group list, select a number.
2. Press   [Call Person].

Dialing out from phonebook
You can call number saved in your phonebook by pressing   
[Call]. 
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Using the share function, you can share files with others.

• Select the contact information you want to share with others and 
press   [Share]  [Via Message]/[Via Bluetooth].

Deleting contact information
To delete contact information

1. Select the contact you want to delete.
2. Press  and select [Delete]  [Delete].

Voice control
You can call others by setting a pre-recorded voice command. You 
can save a maximum of 50-recorded words in your Smartphone. 
There are three seconds available for voice command. Please ensure 
that you are in a quiet environment and use a name that is distinct 
from others when recording.
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To record a voice command

1. When editing a contact, press   [Add Field]  [Voice Tag] 
to access the Add Voice Tag screen, or press   [Add Voice 
Tag] to access the Add Voice Tag screen directly.

2. Press  to record the voice command.

To dial a number
In the idle screen, press and hold  and say the voice command. If 
the command is recognized, the number will dial out.

SIM Phonebook
You can save, edit or delete records on your SIM card. You can also 
import/export records between the SIM and Phonebook.

Viewing records on SIM
To view records on SIM

• In the main menu, select [Phonebook], then select [SIM 
Phonebook]  to access the SIM Phonebook list.
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New records on SIM

• In the SIM Phonebook list, press  to add a new entry. Enter 
the name and number, press  and select [Save] to save the 
new entry.

To edit records on SIM

1. In the SIM Phonebook list, select a record and press  to select 
[Edit Entry] to edit the selected entry.

2. Enter the new name and number, press  and select [Save] to 
save the new entry.
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To delete records on SIM

• In the SIM Phonebook list, select a record, press  to select 
[Delete Entry] and press  to delete the selected entry. 
Alternatively, select [Delete All] to delete all entries on SIM.

Sending messages from SIM
In the SIM Phonebook list, select a record, press  and select [Send 
Message] to access the message edit screen. Press  to send the 
message when finish editing.

Exporting records to SIM
You can export records in your Smartphone to SIM and manage them 
on SIM.

• In the SIM Phonebook list, press  and select [Phonebook to 
SIM] to access the Phonebook on Phone screen. Select the record 
you want to export to SIM and press  to export the record.

Importing records to phone
You can import the records on SIM to phone and manage them in 
your Smartphone.
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 • In the SIM Phonebook list, press  and select [SIM to 

Phonebook] to access the Phonebook on SIM card screen. Select 
the record you want to import to phone and press  to import 
the record.

Name display settings
You can set the name display format of the records in the phonebook.

1. Select [Applications] in [Preferences], then select [Phonebook]  
[Name Format] to set the contacts to be listed by First or Last 
name.

2. Select [Name Sorting] and select Pinyin or Stroke Count sorting 
for phonebook names.
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The PIM includes Calendar, Calculator and Notes features. It allows 
you to quickly and easily schedule appointments or any activity 
associated with a date or date and time, and also sets an alarm for all 
such activities.

Using the Calendar
The Calendar application provides Event, Tasks and Alarms features, 
which you can use to schedule appointments in various ways.

• In the main menu, select [PIM]   [Calendar] to access the 
event list directly.

PIM
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 Creating a new event
1. In the event list, press   [New].
2. Enter a brief description of the event and select the date and time.
3. Press  to save the event.

Sending an event
You can send an event via Bluetooth or Message.

• In the event list (Day view mode), select an event, press  to 
select [Share]  [Via Message]/[Via Bluetooth] and select either 
one to send the event.

Deleting an event 
In the event list (Day view mode), select an event, press  to select 
[Delete] and press  to delete the selected event.

Calendar settings
Select [Applications] in [Preferences], select [Calendar]:

• Task Auto-Delete: Sets the length of time before finished tasks 
are automatically deleted.
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• Alarm Auto-Delete: Sets the length of time before used and non-
repeat alarms are deleted automatically.

• Default Alarm Sound: Chooses the default alarm sound.
• Snooze Time: Sets the snooze time in minutes.

Using the Tasks
You may create tasks to prioritize your daily activities. You can 
manage these tasks in category. All tasks can be sent via Bluetooth or 
Message.

When accessing the Calendar, press  and select [Tasks]. You can 
view the brief description of the tasks in the task list.
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To create a new task

1. In the task list, press  to select [New] and enter a short 
description for the task.

2. Select the Due date, then select the category that the task belongs 
to. (See page93 for category settings)

3. Set the priority of the task.
4. Press  to save the new task.

To edit a task
1. In the task list, select a record and open it.
2. Edit the task as with the creating steps.

Finished task

• When a task has been completed, press  to select [Mark 
Finished] and mark as a finished task.

To delete a task

• In the task list, select a record, press  to select [Delete] and 
press  to delete the selected record; press  to return to the 
task list.
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Task category settings
To create a new category

1. In the task list, press  and select [Category].

2. Press  and select [New]. Enter a name for the new category 
(e.g., Business) and press  to save.

To delete a category

• Select the category you want to delete, press  and select 
[Remove] to delete the selected category.

To rename a category

• Select a category, press  and select [Rename] to enter the new 
category name.

Using the Alarm
The alarm can be set to ring at a specified time within 24 hours. You 
can also set a quick alarm to ring at pre-defined time interval within a 
shorter time (e.g., in 5 minutes).

In the event list, press  and select [Alarms] to activate.
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Adding a new alarm
To add a new alarm

1. In the alarm list, press  and select [New Alarm].
2. Select the Alarm to activate a new alarm.
3. Select the date and time.
4. Input the description of the alarm.

5. Select the ringtone for the alarm and press  to save.
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Quick alarm
There are no time and date limits in quick alarm; the alarm can be set 
within any time you set.

To add a new quick alarm

1. In the alarm list, press  and select [New Quick Alarm].
2. Select the checkbox on the right of Alarm.

3. Select the time and ringtone and press  to save.

Deleting an alarm
Select an existing alarm, press  to select [Delete] and press  to 
delete the selected record.

Turning on / off an alarm
In the alarm list, select an alarm and press  to select [On]/[Off] to 
turn it on or off.
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If you need to make notes, you can achieve this by using the Notes 
application.

Select [Notes]  in [PIM] to activate.

Adding a new note
To add a  new note

1. In the notes list, press  to add a new note.

2. Enter the new content and press  to save.

Managing notes
To edit a note

• In the notes list, select a record you wish to edit and press . 
Alternatively, press  to select [Edit], enter the new content, 
and then save.

To delete a note

• In the notes list, select a record you want to delete, press  to 
select [Delete] and press  to delete.
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To send a note

• Select a note, press  and select [Share] to send via Message or 
Bluetooth.

To record a new voice note
• Select to record a sound file.

Using the Calculator
Your Smartphone has a standard calculator, you can use to add, 
subtract, multiply, divide and calculate percentages.

In [PIM], select [Calculator]  to use it.
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 • Input a number and press  /  /  /  /  to perform add, 

subtract, multiply, divide and equal. Press  to delete a wrong 
number.

• Press  to select the basic function:
– %: Percentage
– +/-: Switch the Positive and Negative number.
– Sqrt: Calculate the square roots.
– 1/x: Select to perform the reciprocal operation.
– M+: Select to store an entered value in the memory.
– M-: Select to subtract the entered value from the value in the 

memory.
– Recall: Restore the entered value from memory.
– Store: Store data in memory.
– Clear: Clear all contents in memory.
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Entertainment

You can take pictures and videos with the built-in camera in your 
Smartphone, and send them via MMS to your friends. You can also 
send the pictures and videos saved in your Smartphone to computers 
via Bluetooth. 

Note: To use the MMS service, you need to register first. Please con-
tact your network service provider for details.

Using the Camera
To activate the Camera

1. To activate the camera, either:
• In the main menu, select [Camera]  to access the viewfinder 

screen; or

• Press the camera button on the side of your Smartphone in the 
idle screen.

Camera
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2. Place the phone in a landscape orientation. If required, press  
to select the right settings.

3. Press the camera button , or press  to capture. You can find 
the photos in the Pictures application. (Press  to switch to 
video mode)

To take a self-portrait
Hold the phone so that you can see your reflection in the mirror next 
to the lens, press the camera button  to activate the camera, and 
press  or press  again to take photo.

To adjust brightness
In the viewfinder screen, press / to adjust brightness. Press  /

to zoom in/out the image.
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Note: Do not take pictures directly into the sun, as the picture may 
become black or discolored.

When finish taking pictures, select [Media] , then select [Pictures] 
 to choose pictures for viewing.

Camera options
When using camera, you may need to change some of the settings, for 
example, taking pictures at night. In addition to flash, you can also 
select the resolution, size and quality of the pictures.

Preference settings
1. In the viewfinder screen, press  to open the Options menu.
2. Press  /  to select the option settings you want to change.
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• Self Timer: The picture is taken 10 seconds after activation.
• Set Size: Sets the size for pictures/videos.

– Pictures: High resolution/Email/Picture
– Video: No Limit/Video Message (In video mode)

• Flash: Turns on to enhance the lighting conditions.
• Reset Exposure: Resets exposure to default value.
• Reset All: Resets all settings to default value.
• New Video: Switches to video screen.
• Help: Displays Help.
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Editing pictures
When you have finished taking picture, wait a few seconds, then 
press  to select [Review Last]. Press  and select [Edit] to 
access the picture edit screen, press the navigation keys  /  /  / 

 to move the picture.

1. Press  to display the Stamp list. Select the desired stamp to 
add to the picture and press  to confirm the selection and close 
the Stamp list. Press  /  /  /  to move the selected stamp to 
the right place on the picture,  then press .

2. Press  to display the Options menu:
• Done: Select to ask whether to save the current edited picture.
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• Effects: Select different effects for your picture: tint, sepia, 
greyscale and negative.

• Image: Adjust the resolution for the current picture. Select one of 
the following options to display the adjustment screen, press /

 to adjust the resolution and press  to confirm your 
adjustment when finish.
– Resize 
– Color
– Brightness
– Saturation

• Frame: Add the frame to the current picture; there are 5 types of 
frames to select.

• Rotate: There are two types of rotation mode, clockwise and 
anticlockwise.

• Zoom: Zoom function for the current picture: zoom in, zoom out 
and zoom to fit.

• Share: Select the transfer method to send the picture.
• Help: Display Help.

3. Press  to select [Done] to save the newest picture.
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Pictures application allows you to manage pictures saved in your 
Smartphone. (Including those taken by phone, received via MMS, 
email, Bluetooth, or those downloaded online.) You can also edit all 
images using Pictures application.

Using the Pictures
To activate the Pictures 

1. In the main menu, select [Media]   [Pictures]  to access 
the Pictures application.

Pictures
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2. Select a category (the number of pictures is displayed at the 
bottom of the category name) and press  to preview the 
thumbnail image.

3. Select a picture and press  or  to view.

4. In the picture view screen, press  to zoom in/out the picture; 
press /  to view the previous/next picture.

Options in pictures view
In the picture view screen, press  to display the Options menu:
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• Full Screen: Select to view pictures in full screen.
• Modify

– Edit: Select to edit the current picture (See page103)
– Rotate Right: Rotate the picture in clockwise.
– Rotate Left: Rotate the picture in anticlockwise.

• Wallpaper: Set the current picture as the wallpaper, which can be 
seen in the phone idle screen.

• Details: Select to view the picture details, including the name, 
file type, location, file size and dimensions. Press  to return to 
the previous screen.

• Add to Gallery: Add the current picture to the gallery you create 
yourself. In the personal gallery, press  to confirm the picture 
has been added to the personal gallery; press  to go back.

• Slide show: Select to play the pictures in a continuous slide 
show; press  to stop playing.
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Managing pictures 
Exchanging pictures
You can exchange pictures via Bluetooth or MMS with other phones, 
remote devices and computers.

To send a picture
1. In the thumbnail view screen, select the picture you want to send.
2. Press , select [Share] and select a transfer method.

To receive a picture
• If you receive a picture in a message, select the picture and save; 

if you receive a picture via Bluetooth, follow the instructions 
displayed on screen.

Adding the incoming picture to contacts
You can add a picture to any contact so that the picture is displayed 
when there is an incoming call from that person.

1. In the thumbnail view screen, select the desired picture.
2. Press  to select [Attach To Person] and access the contact list, 

select a contact and press  to add.
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Renaming/copying/deleting/moving pictures
1. In the thumbnail view screen, select the picture you wish to 

rename, copy, delete or move.
2. Press  to select [Modify], and then select the desired 

command to edit the picture.

Categories in pictures
In the pictures list, there are three default categories: Pictures Library, 
Recent Pictures and Frequent Pictures. Additionally, you can create a 
personal gallery.
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To add a new gallery

• Press  to select [New Gallery], enter a name for the new 
gallery and press  to save.

To rename/clear/delete gallery
1. Select a personal gallery.

2. Press  to select [Rename Gallery]/[Clear Gallery]/[Delete 
Gallery].

To move a selected gallery up or down
1. Select a personal gallery.

2. Press  to select [Move up]/[Move down] to move the selected 
gallery up or down.

Note: The three default galleries cannot be changed. 
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You can play music on your Smartphone wherever you wish. You can 
download music from any computer, the Internet or from a 
Smartphone expansion card. MP3 and Midi music files are supported.

Accessing the Audio player
To activate the Audio player

1. In the main menu, select [Media] icon , then select [Music] 
icon  to access the Audio player.

2. Select a category (the number of songs is displayed at the bottom 
of the category name) and press  to access.

3. Select a file in the selected category (e.g., [Music Library]), press 
 or  to access the playing screen and play the selected file.

Audio player
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Playing sound files
To play sound files

1. When you access the playing screen, the system will play the file 
automatically.

2. Press  or  to pause; press  or press  again to 
continue.

3. Press /  to select / . Press  to play the previous/next 
song.
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Managing files
To manage sound files

1. In the playing screen, press  to display the following items:
• Repeat: Select Repeat to play the songs repeatedly.
• Shuffle: Select Shuffle to play the songs randomly.
• Details: Check details of the current song.
• Add to Playlist: Select to add the current song to the playlist you 

create. Access the playlist and press  to confirm the song has 
been added to the playlist; press  to go back.

• Hide Player: Select to hide the current playing screen and return 
to the phone idle screen.

• Help: Display help document for the current file.

2. In the Music library list, press  to open Options menu:
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• Share: You can send sound files via Bluetooth or MMS. Press 
 to select [Share] and select a transfer method.

• Attach To Person: You can add a sound file to a contact. When 
there is an incoming call from the contact, the selected sound acts 
as a ringtone for that person.
– In the library list, select the desired song.
– Press  to select [Attach To Person] to access the contact 

list, and select a desired contact. Press  to add the song.
• Modify

– Rename: Rename the current selected sound file.
– Delete: Delete the current selected sound file,  [Delete]/

[Cancel].
– Copy to Card: Copy the current selected sound file to card.
– Move to Card: Move the current selected sound file to card.

• New Voice Note: Select to record the voice command. You have 
30 seconds to record the sound file. Press  to finish recording.
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Managing playlist
In Music screen, there are three default categories: Music Library, 
Recent Music and Frequent Music. Additionally, you can create a 
personal playlist.

To add a new playlist

• Press  to select [New Playlist] and enter the new playlist 
name. Press  to save.

To rename/clear/delete playlist
1. Select a personal playlist.



116

E
n

tertain
m

en
t

2. Press  to select [Rename Playlist]/[Clear Playlist]/[Delete 
Playlist].

Note: If there are no files in the personal playlist, [Clear Playlist] is 
unavailable. You can delete or rename a personal playlist.

To move a selected playlist up or down 
1. Select a personal playlist.

2. Press  to select [Move up]/[Move down] to move the selected 
playlist up or down.

Note: The three default playlists cannot be changed. 

You can play a video clip captured with your Smartphone. You can 
also download video clips from the Internet or transfer video clips 
from your computer to your Smartphone. You can exchange the video 
clips between phones via Bluetooth or MMS. Both MP4 and MPEG 
file formats are supported.

Video
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Using the Video application
To activate the Video application

1. In the main menu, select [Media]   [Video] to activate.
2. Select a category (the number of the videos is displayed at the 

bottom of the category name) and press  to access.

3. Select a file in [Video Library], press  or press  to access 
the playing screen and play the selected file.
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Capturing video clips
In the Video library, press  to select [New Video] to access the 
capturing screen. Press to capture the video clip; press  again to 
stop capturing. You can play the video in the Video library when you 
finish capturing.

Please see page101 for details about option settings for the Video 
function. 
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Playing video clips
To play video clips

1. Video clips will automatically play when you access the playing 
screen.

2. Press  or  to pause and press  or  again to continue.

3. Press /  to select / . Press  to play the previous/next 
video clip.
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Managing video files
To manage video files

1. In the playing screen, press  to display the Options menu:
• Full Screen: Select to play the video clip in full screen.
• Details: Select to check the details of the current file.
• Add to Gallery: Select to add the current file to the personal 

gallery. In the personal gallery, press  to confirm the file has 
been added.

• Show Controls: Select to display the control bar as the following 
display.

• Help: Display the help text document.

2. In Video library, press  for the Options menu:
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• Share: You can send video files via Bluetooth or MMS. Select a 
transfer method to send files.

• Attach To Person: You can add a video file to a contact for video 
Caller ID, when the contact calls you, the specified video plays.
– In the library list, select the desired file.
– Press  to select [Attach To Person]. Select a contact in the 

contact list and press  to add.
• Modify

– Rename: Rename the current selected video file.
– Delete: Delete the current selected video file,  [Delete]/

[Cancel].
– Copy to Card: Copy the current selected video file to card.
– Move to Card: Move the current selected video file to card.

Managing playlist
In Video screen, there are three default categories: Video Library, 
Recent Video and Frequent Video. Additionally, you can create a 
personal playlist.
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To add a new gallery

• In the playlist, press  to select [New Gallery]. Enter a name 
for the new gallery and press  to save.

To rename/clear/delete gallery
1. Select a personal gallery.

2. Press  to select [Rename Gallery]/[Clear Gallery]/[Delete 
Gallery].

Note: If the personal gallery is empty, [Clear Gallery] is will not be 
available. You can delete or rename a personal gallery.

To move a selected gallery up or down 
1. Select a personal gallery.

2. Press  to select [Move up]/[Move down] to move the selected 
gallery up or down.

Note: The three default categories cannot be changed. 
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Media application settings
You can set the size of a picture or video.

In the main menu, select [Preferences]  [Applications]  [Media] 
and change the following settings:

• Auto Advance: Select to set the viewer to advance to the next 
item automatically.

• Timing: Enter the number of seconds (0 to 300) to show each 
picture before displaying the next. Use 0 for manual advance.

• Orientation: Specify whether you are right or left-handed. (This 
determines how the controls are displayed.)
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Connectivity

In the Networks application, select Networks to adjust your network 
settings and set the selection mode to automatic or manual. After 
adjusting your network settings, you can use the Internet services 
available from your network service provider.

Note: Please contact your network service provider for the Internet 
service you can use.

In the main menu, select [Preferences]   [Networks].

Network selection
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Choosing a network
In [Networks]  [Choose Network], your Smartphone will search for 
the available networks and display them in a list. Select the network 
you need and press . 

Preferred networks
In [Networks]  [Network Selection], the currently available 
networks are displayed. You can add or delete a network.

To add from available

• Press  to select [Add from available]. Select a new network 
and add it to preferred networks.

To add from known
• Press  to select [Add from known]. Select a new network and 

add it to preferred networks.

To delete a network
• Select the network you want to delete in preferred networks. 

Press  and select [Delete].
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Network selection
Select [Network Selection] and set the selection mode to automatic or 
manual.

Your Smartphone has built-in Bluetooth wireless technology that 
makes it possible for you to connect to other Bluetooth-enabled 
devices, such as a PC or another Smartphone. You can send pictures, 
video clips and memos via Bluetooth.

To use Bluetooth, you must first set up a connection with another 
device and make it a trusted device. Your Smartphone remembers this 
device even if you turn your phone off.

Note: To communicate clearly, your Smartphone and the target 
Bluetooth device must be within 10 meters of each other with 
no intervening obstacles.

Bluetooth wireless technology
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Turning Bluetooth on
To communicate with another Bluetooth device, you must first turn  
Bluetooth on and add the target device.

To turn Bluetooth on
• In the main menu, select [Preferences]  [Connectivity]  

[Bluetooth]  to access the Bluetooth. Press  to turn on 
Bluetooth.

• Alternatively, in the idle screen, press  to select Bluetooth.
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My devices
To add devices to your Smartphone

1. In the Bluetooth screen, select [My Devices].
2. Press  to select [Add New Device]. Your Smartphone will 

search for all available devices.
3. Once the search is complete, a list of available devices is 

displayed. You may select a device for connection.
4. If the device you are adding to your Smartphone has its own 

passcode, you need to enter the code.
5. The new device is displayed in my devices list.

To organize the list of devices

1. Press  to select [Trusted] to turn on/off the connection of the 
selected device.

2. Select [Remove Device] to remove the selected trusted device.

My phone
Select [My Phone] and enable Bluetooth first. Input a name for your 
phone and make your Smartphone visible to other devices.
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To enter a phone name
You can input a name for your Smartphone. This name is displayed 
when your Smartphone is discovered by another Bluetooth device.

• Select [My Phone]  [Phone Name] and enter a phone name. 
When Bluetooth is turned on, the name is shown on the other 
device.

To hide or show your Smartphone via Bluetooth
• Select [My Phone]  [Discoverable]  [On], your Smartphone is 

visible to other devices,  [Off],   your Smartphone will not be 
discovered by other devices.
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Sending and receiving
When you select Bluetooth as the transfer method, a list of available 
receiving devices is displayed. And the last device you connected to 
will be in the list.

You can only connect to one Bluetooth device at a time.

To send an item
• Select the item you want to send (e.g., the phonebook contact), 

select [Phonebook]; select a contact and press  to select 
[Share]  [Via Bluetooth]. Your Smartphone will search for 
available devices, then you can select the device you want to send 
item to, and press  [Send] to initiate the transfer.

To receive an item
• When you receive an item, please follow the instructions on the 

screen to accept the transfer.

To end a connection
• After sending or receiving an item, the Bluetooth connection is 

turned off automatically.
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You can synchronize your Smartphone contacts, notes, tasks to 
programs on your PC or on any other Bluetooth enabled device.

Starting synchronization  
To start synchronization

1. In the main menu, select [Utilities]   [Sync] .
2. You can synchronize your calendar and phonebook data with 

other PC.
3. Select [Calendar] and/or [Phonebook].
4. Press  to start to synchronize.

Note: The phone may stop suddenly while synchronizing. If this 
happens, check your network settings or contact your network 
service provider for more information.

Synchronizing
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You can adjust the network settings for Messaging, GSM (Global 
System for Mobile Communications), GPRS (General Packet Radio 
Service), and your browser in the Advanced Settings menu.

Activating the advanced settings
In the main menu, select [Preferences]  [Advanced Settings].

Advanced settings
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Gateways
The gateway settings should be automatically loaded by your network 
service provider, however, you may also manually add gateway 
settings from this screen.

Note: Gateway settings are normally loaded into your Smartphone 
automatically by your network service provider prior to pur-
chase. You should only change these settings when requested 
to do so by your network service provider.

To add a new gateway
In the Advanced Settings, select [Gateway] and press  to add a 
new gateway.

• Name: Choose a name for the gateway and press  to save.
• Active: Select [Yes]/[No]. Choose Yes to make this gateway 

available for participation in routing. Otherwise, choose No.
• WAP default: Select [Yes]/[No]. Choose Yes to make this a 

default WAP Gateway. Otherwise, choose No.
• MMS default: Select [Yes]/[No]. Choose Yes to make this a 

default MMS Gateway. Otherwise, choose No.
• Gateway address: Enter the IP address for the gateway, you may 

obtain this information from your network service provider.
• Connection Mode: Select [Oriented]/[Less]. Choose Oriented to 

use the connection oriented protocol (the default), or Less to 
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choose the connectionless. You may obtain this information from 
your network service provider.

• Security: Select [Yes]/[No]. Choose Yes to use a secure WAP 
connection. (Only if your network service provider supports this 
feature.) Otherwise, choose No.

• Push enabled: Select [Yes]/[No]. Choose Yes to allow your 
network service provider to send you WAP content. (Only if your 
network service provider supports this feature.) Otherwise, 
choose No.

• Push server: Choose the server that the push has been enabled.
• Username: Enter the username for this gateway.
• Password: Enter the password for this gateway.

To delete a gateway
• Select a gateway you want to delete in Gateways.

• Press  to select [Delete] and press  again to delete.

GPRS 
The GPRS Access (APN) settings should be automatically loaded by 
your network service provider, however, you may also manually add 
new GPRS APNs from this screen.
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Note: GPRS settings are normally loaded into your Smartphone 
automatically by your network service provider prior to pur-
chase. You should only change these settings when requested 
to do so by your network service provider.

To add a new GPRS APN
In the Advanced Settings, select [GPRS] and press  to add a new 
GPRS APN.

• Name: Choose a name for the APN and press  to save.
• Use as default: Select [Yes]/[No]. Choose Yes to set this 

Smartphone default.
• APN name: Enter the APN or IP address. Obtain this information 

from your network service provider.
• Use password: Select [Yes]/[No]. Choose Yes if this APN 

requires a username or password. Obtain this information from 
your network service provider.

• Username: Enter the username for this APN from your network 
service provider if required.

• Password: Enter the password for this APN from your network 
service provider if required.

• IP address: Enter the fixed IP address for GPRS from your 
network service provider if required.
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• DNS address: Enter the fixed IP address for DNS Server from 
your network service provider if required.

To delete GPRS APN
• In the GPRS APN, select an APN you want to delete.

• Press  to select [Delete], Select [Yes] to delete the selected 
APN, otherwise, select [No].

To set as default
• In the GPRS APN, select an APN you want to set as default.

• Press  to select [Set as default].

GSM Dialup 
The GSM Dialup (CSD) connection settings should be automatically 
loaded by your network service provider, however, you may also 
manually add dialup servers from this screen.

Note: GSM dialup connection settings are normally loaded into 
your Smartphone automatically by your network service pro-
vider prior to purchase. You should only change these settings 
when requested to do so by your network service provider.
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To add a new GSM dialup connection
In the Advanced Settings, select [GSM Dialup] and press  to add 
a new GSM dialup connection.

• Name: Choose a name for the dialup connection and press  to 
save.

• Active: Select [Yes]/[No]. Choose Yes to make the Smartphone 
default. Otherwise, choose No.

• Dialup number: Enter the phone number for dialup access.
• Use password: Select [Yes]/[No]. Choose Yes if this dialup 

server  requires a username or password. You may obtain this 
information from your dialup provider.

• Username: Enter the username for this dialup server from your 
dialup provider if required.

• Password: Enter the password for this dialup server from your 
dialup provider if required.

• Data rate: Select [9600]/ [14400]/[Maximum], select the desired 
rate and press .

• IP address: Enter the fixed IP address for GPRS from by your 
network service provider if required.

• DNS address: Enter the fixed IP address for the domain name 
server from by your network service provider if required.

To delete a GSM dialup connection
• In the GSM Dialup, select the account you want to delete.
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• Press  to select [Delete]  [Yes] to delete the selected 
account. Otherwise, select [No].

To set as default
• In the GSM Dialup, select an account you want to set as default.

• Press  to select [Set as default].

Reset
You can reset all network settings to factory defaults. Select [Reset] 
in [Advanced Settings].

Settings reset
Select [Settings Reset] in [Reset] to reset all settings and 
configuration to factory defaults. Press  to continue, or press  
to return.

Master reset
Select [Master Reset] in [Reset] to reset all settings and configuration 
to factory defaults and clear all your data. Press  to continue or 
press  to return.
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Note: All user data will be erased by performing master reset, you 
will require the password “2468” to proceed.

WEB
Select [Web] in [Advanced Settings] to adjust the Web settings.

Connection
Select [Connection] in [Web] and choose an APN from the list.

Messaging
Select [Messaging] in [Advanced Settings] to set SMS, MMS, Cell 
Broadcast. (See page65 for details)
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Customizing

There are a number of ways for you to change the Smartphone’s 
settings to suit your requirements.

Profiles
You can adjust the profiles according to the certain environment. You 
can see the current profile type on the status bar.

Profile settings
1. In the main menu, select [Preferences].

2. Select [Profiles] to set the ringtone, volume, etc. Press  to set.
Tips: Simple way! In the Smartphone idle screen, press  to    

select [Profile] and set profile mode.

Customizing your Smartphone
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Phone settings
You can change the background image for the idle screen, and set the 
images saved in the Smartphone as the wallpaper. In addition, you 
can change the font size, set the backlight timeout, etc. Language can 
also be changed.

Setting wallpaper
1. In [Preferences], select [Phone Settings]  [Display]  

[Wallpaper].
2. Select the image you want to set as the wallpaper, and press .

Themes
You can change the appearance of the screen via the Themes. Your 
Smartphone comes with four predefined themes, you can also 
download new themes to expansion cards and install on your 
Smartphone. Themes can control the color of the screen, text, icons, 
and wallpaper.

To view themes
Four predefined themes and the themes you download to your 
Smartphone are present in the themes list. The current theme is 
marked with a tag.

1. Select [Themes] in [Display].
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2. Scroll to the desired theme. Press  to select [Details] and view 
the details of the selected theme.

3. If there is a URL in the details view screen, press  to visit the 
site.

To change themes
In the themes list, select a theme and press  to set. Returning to 
the phone idle screen, the color of the screen, icons and wallpaper are 
changed to the theme style you select. If the selected theme is 
currently in use, you will not be able to re-select this theme.

To download themes
You can download new themes to an expansion card, and install on 
your Smartphone. Insert the expansion card containing your 
downloaded themes into your Smartphone before the installation.
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1. In the themes list, press  to select [Install New] and you can 
see all the available themes. Select the one you want to install on 
your Smartphone and press .

2. Select the theme you just download to card  in the theme list, and 
change it to be the new theme.

To delete themes
In the themes list, select the theme you want to delete and press  
to select [Delete]. Press  to delete.

Note: You can delete themes in your Smartphone. The theme in use 
and the predefined themes cannot be deleted.

Menu style
Your Smartphone provides two kinds of menu style, icon and list. 
Select [Menu Style] in [Display] and select the menu style.

Language selection
Select [Language] in [Phone Settings]. Select the language for the 
display and press . You must restart your Smartphone for the 
language selection to take effect.
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Security settings
You can modify the security settings on your Smartphone to provide a 
safer connection to the Web. 

Note: Please insert the SIM card first before setting security.

In the main menu, select [Security] in [Preferences].

• Lock Phone: Select to lock your Smartphone. If your 
Smartphone has been locked, it should be [Unlock Phone], 
unlock phone, enter the PIN code.

• Change PIN: Select to change the PIN code.
• Change PIN2: Select to change the PIN2 code.
• View Security Certificates: Choose a certificate and use details to 

display its issuer, validity, fingerprints and other details.
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Clock settings
To set the time, date and time zone in Clock.

1. Select [Set Clock] in [Preferences].
2. Enter the time, date and select the time zone.
3. Press  to save.
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You can back up phonebook data to the expansion card and restore 
them at any moment. It is recommended that you back up your 
Smartphone data on a regularly basis.

Please insert the expansion card before using the Backup application 
(See page19 for inserting expansion card).

Back up data
To back up data

1. In the main menu, select [Backup]  in [Utilities] .

2. Press  to back up phonebook data on your Smartphone to the 
expansion card, following the instructions on the screen.

3. Done.

Backup and restore
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Restore data
You can restore the phonebook data if you have lost the data on your 
Smartphone.

To restore data

1. Press  to access the Available Backups screen.

2. Select the data you need to restore and press  to start.
3. Done.
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The Application Manager allows you to view, install, move, copy and 
share installer files; or to remove installed applications.

You can install many applications and MIDlets that are compatible 
with SavaJe OS 2.5.

Application Manager
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Accessing the Application Manager
To activate Application Manager

• In the main menu, select [Application Manager]  in [Utilities] 
. There are two options in Application Manager: Install 

Software and Uninstall Software.

Installing applications
The applications can be received via MMS, email, or from another 
mobile device via Bluetooth.
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To install an application
1. Select [Install Software]. Select the application you want to 

install on your Smartphone and press .

2. Once installation is completed, press  to activate the installed 
application.

To move/copy an application

• In the application list, select an application and press  to 
select [Move To]/[Copy to] in order to move/copy the selected 
application.

To send an application
• In the application list, select an application you want to send. 

Press  to select [Share] and send out the application via 
messaging.
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Uninstalling applications
To uninstall an application

1. Select [Uninstall Software].

2. Select the application you want to remove and press  to 
uninstall.

Note: If you uninstall an application, other associated applications 
or files created by the uninstalled application may not run 
properly.



152

T
ro

u
b

le sh
o

o
tin

g

Trouble shooting
This chapter lists some problems you might encounter while you use 
the Smartphone. Some problems require you to call your network 
service provider, but most of the problems you can easily correct 
yourself.

If you need to hand in your Smartphone to repair, you might lose the 
data you save in your Smartphone. So, we strongly recommend that 
you make a copy for these information before you hand in your 
Smartphone for repair.

Master reset
You can return the phone to its original state by deleting the content 
you added or edited.

• Select [Settings Reset] to reset all settings and configuration to 
factory defaults.

• Select [Master Reset] to reset all settings and configuration to 
factory defaults, and clear all your data. For example, contacts, 
messages, and the contents you received or downloaded.

Please see page138[Reset] for details.
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The Smartphone cannot be switched on
• Recharge or replace the battery (Please see page13-15 for 

“Installing battery and Charging battery”).

The Smartphone does not work
• The received signal is too weak, you are possibly shielded from 

the signal. Move outdoors or up from ground to receive 
sufficiently strong signals.

• If emergency call only is displayed on the screen, you cannot use 
the network within range, however, you still can make an  
emergency call.

WAP cannot be used
• The settings are not correct. Enter new settings, or contact your 

network service provider.

Cannot send or receive message
• Check with your network service provider that you have correctly 

enter the Service Center phone number.
• The phone memory is full and delete some unwanted files.
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No indication of charging
• When you are charging a battery that is empty or a battery that 

has not been used for a long time, it may take you a few minutes 
before the strength signal displays on the screen.

Numbers are not permitted
• You may have activated the fixed dialing function, and the 

number you are calling out is not in the fixed dialing list.

Cannot use Bluetooth wireless technology
• Make sure you have turned Bluetooth on.
• Make sure the device is within the valid range (within 10 meters)
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Mobile PhoneTools

Minimum requirements
Mobile PhoneTools requires Windows® 2000 or XP. For other 
operating systems and any information concerning upgrades, contact 
BVRP Software or your distributor.

For mobile PhoneTools to operate properly, please verify the 
following:

• A PC with a Pentium® II 233 MHz computer, connected to your 
mobile phone with a USB cable.

• One available USB port to make a cable connection.
• Local hard drive with 20MB free space.
• Mobile phone or Drive that is compatible with mobile 

PhoneTools.
• Minimum active memory: 64MB of RAM under Windows® 2000 

and XP.

Basic introduction
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Before installing
Screen shots
The screen shots in this guide correspond to the use of mobile 
PhoneTools in Windows 2000 environment. When running the 
application in other Windows operating systems, the aspect of the 
screens may change. This will not impair the software’s functionality.

Online help
Mobile PhoneTools has a context sensitive online help that can be 
accessed by clicking the help button or by pressing F1 on your 
keyboard. Complete information on how to use mobile PhoneTools 
can be found in the help files.

Installing mobile PhoneTools

Note: You need to install the software before connecting the device 
to the PC

To install mobile PhoneTools on your hard drive, insert the CD-ROM 
containing the program in the appropriate drive. When installing 
mobile PhoneTools from the CD-ROM, the installation process starts 
automatically.
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Should the installation program not start. execute the following 
instructions:

1. Select [Run] command from the [Start] menu (accessible from 
the task bar).

2. Select the drive that contains the CD or type D: SETUP (D: 
represents the CD-ROM drive).

3. Click [OK] to run the file.
An installation wizard will guide you step-by-step through the 
installation process, prompting or information where needed. During 
the installation process the content of the CD-ROM is copied onto 
your hard drive and a program group is created to hold the application 
icons for mobile PhoneTools.

After installation, the online registration wizard is automatically 
launched. The registration is necessary to benefit from the guarantee, 
the technical assistance, and free upgrades.

Depending on the operating system, when the installation process is 
completed, the installation wizard asks you to restart your computer 
so that all system changes take effect.

The mobile PhoneTools program group is then accessible from the 
Start menu (from the task bar) and the following icon can be added to 
the desktop, as a short-cut, to start the program: mobile PhoneTools 

.
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Mobile device installation and configuration

Note: Please do not connect your mobile or your mobile device to 
your PC until instructed to do so by the MPT software instal-
lation wizard.

1. Launch the mobile PhoneTools application.
2. Once your software has been set up to work with your mobile 

phone or device, the application interface will appear. However, 
if we do not detect the connection type we will display the phone 
setup screen.

3. Connect your phone to your PC, your phone will be detected and 
setup automatically. The application will be launched at the end 
of the installation process.

Uninstalling mobile PhoneTools
1. In the Windows task bar, click the [Start] menu and select 

[Control Panel]. The Control Panel window opens.
2. In the list, double-click the [Add/Remove program] option.
3. Highlight the mobile PhoneTools program group and click the 

[Change/Remove] button. The uninstallation process starts.
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Online registration
To benefit from the guarantee, free upgrades, register online with our 
services. The online registration wizard is automatically launched at 
the end of the installation process. Simply follow the instructions 
displayed on the screens.

Check that your Internet access is available and properly set up to 
ensure an automatic Internet connection.

If online registration could not be completed during installation, you 
can also register at any other time using [Menu]  [Help]  [Online 
Registration].
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Mobile PhoneTools main window
With mobile PhoneTools you can share the information contained on 
your PC with your mobile phone. When your mobile phone is 
connected to your computer, you can perform the following 
operations:

• Synchronize your phonebooks.
• Send modified music clips and images to phone from PC.

Note: Some of mobile PhoneTools features might not be available 
with your phone or device.

Press to view 
online help

Press to minimize mobile 
PhoneTools and place its icon 
in the tray bar of your PC’s 
desktop as shown below: 

Double-click here to have 
the mobile PhoneTools 
window displayed

Press to close mobile 
PhoneTools

Battery strength indicatorShows the 
strength of the 
network signal

When connected, your 
service provider’s 
name displays here

Press to open the 
functions panel (You 
can also press Menu > 
View > Functions 
Panel to open it). Press 
again to close the panel

Press to access all the 
functionalities and setup 
options of mobile PhoneTools
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Mobile PhoneTools function panel
Displays the Phonebook. Synchronizes your phonebook. Displays 
information regarding mobile phone.

Note: Some of mobile PhoneTools features might not be available 
with your phone or device.

Icon description: 
Launches or ends the default Internet 
connection.

Displays the Phonebook.

Displays the Calendar.

Displays the Multimedia Studio
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Additional information
Keyboard shortcuts

F1 Online help F3 Outbox        F4 Inbox              

F5 Phonebook F6 General setup          F7 Calendar menu

F8 Transmission logbook  F9 Reception logbook F10 Menu

Websites

Please visit our website to obtain the latest information on our 
products and available upgrades: http://www.bvrp.com

Copyright and trademarks
©2001-05 BVRP Software. All rights reserved.

Mobile PhoneTools is a registered trademark of BVRP Software S.A.

All product names mentioned in this document are trademarks or 
registered trademarks of their respective owners.



  
M

o
b

il
e 

P
h

o
n

eT
o

o
ls

63
1

Note: Make sure your Smartphone is connected to your PC before 
starting mobile PhoneTools.

• On your desktop, double-click on the icon  to launch the 
application.

Setup an Internet connection
mobile PhoneTools functions (Internet, etc.) can be accessed by 
connecting to various wireless telephone networks. Networks 
availability and functionality is dependent upon your wireless 
network service provider. 

Note: Data service is a network and subscription dependent feature 
that may not be available in all areas. Please contact your 
wireless network service provider for details. 

1. Click the Internet button  from the mobile PhoneTools 
function panel. The screen of Internet Connection is displayed.

2. When the connection icon  represents on the taskbar on 
your PC, the Internet Connection becomes available.

Starting mobile PhoneTools
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Creating a new email account
The email module allows you to exchange email messages over the 
Internet, using SMTP (Simple Mail Transfer Protocol) to send mail 
and the POP3 protocol (Post Office Protocol version3) to receive 
mail.

If you imported an existing email account, the various fields in the 
General Setup dialog box are filled in automatically.

If you did not import an account, you must add an account and fill in 
all the fields: 
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Sending an email 
1. From the main menu, choose the [Send] option then select the 

[Send E-mail] option. The Send email window appears. (Or you 
can compose a new email from the Inbox, from main menu, select 
the [Receive] option, then select the [Inbox] option)

2. Fill in the recipient(s)’s name and email address or click the  
button  in order to get the information from the phonebook. 

3. Enter the subject in Subject and the email text in the text field 
below the Subject. you can enlarge the text edit field via pointing 
the mouse cursor to the lower edge of the window (the cursor 
takes an up-down arrow shape) and, while holding down the left 
mouse button, drag the mouse until the window reaches the 
desired size.

4. Click [Send]. 

Phonebook
You can use phonebook to store the details of your correspondents.

Do one of the following to access phonebook:

• Press the F5 key on your keyboard;
• Click the phonebook button  from the function panel;
• Click the Menu button, select the [Organizer] option then select 

the [Phonebook] option.
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Creating a phonebook
It may be helpful to create several phonebooks in order to access to 
the correspondent contacts easier.

1. From the phonebook, click on the [File] menu, then select [New].
2. Enter the new name and specify the drive and the folder you want 

to save it in. 
3. Click [Save].
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Opening a phonebook
1. From phonebook, Click on [Open] button, or select [Open] from 

the [File] menu.
2. Select the type of phonebook you want to open.
3. Click the [Open] button.

The selected phonebook becomes the current phonebook: it is 
opened as the default phonebook each time you access 
phonebook.
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Creating a record
1. From the phonebook, click the [New] button.
2. Click in the fields you want to fill out and enter your 

correspondent’s contact details.
3. Click the [Save] button

Phonebook synchronization
You can synchronize the phonebook in your Smartphone with the 
software you are using on your computer. (Please see page171 for 
synchronization.)

Calendar
The calendar module makes it easy for you to manage your time, 
wherever you are. You can synchronize the calendar (event, task) in 
your Smartphone with the software you are using on your computer. 
(Please see page171 for synchronization.)
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Do one of the following to access phonebook:

• Press the F7 key on your keyboard;
• Click the phonebook button  from the function panel;
• Click the Menu button, select the [Organizer] option then select 

the [Calendar] option.
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Creating a new calendar
1. From the calendar, click on the [File] menu, then select the [New 

Calendar] option. The New Calendar window is displayed.
2. Enter the calendar name and specify the drive and folder you 

want to save it in. Application calendar files are automatically 
given the .MDB extension.

3. Click [Open].

Scheduling a new event
1. Do one of the following to schedule a new event:
• In the [Edit] menu, select [New]  [Event]. 
• Right-click in the Schedule window (central display area), then 

select [New record].
• Click on the New icon  in the toolbar.

2. Enter the data with the onscreen instruction.
3. Click [OK].

Creating a new task
1. Do one of the following to schedule a new event:
• In the [Edit] menu, select [New]  [Task]. 
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• select [Task] from the scrolling list to the right of 
.

2. Enter the data with the onscreen instruction.
3. Click [OK].

You also can delete, edit or import/export data in the software.

Synchronization
Synchronization enables you to update your phonebooks and 
calendars.

• Numbers saved in your Smartphone phonebook to those saved in 
the phonebook application,

• And/or events/tasks saved in your Smartphone calendar to those 
saved in the calendar application.

Note: Depending on which Smartphone you have, the tabs available 
in the Synchronization Settings window may vary or not all be 
available or visible. 
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Synchronization settings
1. Click the Menu button from the application main window.
2. Select [Setup] in the drop-down menu, then select 

[Synchronization Settings].

3. Check the options you wish to enable.
4. Move to another tab if necessary or click [OK] to confirm and 

close the Synchronization Settings window.
5. When finish setting, you can select Synchronize option in 

phonebook and/or calendar to perform synchronization.
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Multimedia Studio
The Multimedia Studio is a powerful tool. It lets you manage all the 
multimedia functions of your Smartphone on your PC simply and 
efficiently. You can create and modify melodies using Melody Studio, 
or photographs using Image Studio. You can also create and / or edit 
movies thanks to the Video Studio, and transfer them on your 
Smartphone.

Mobile Explorer
Mobile Explorer allows you to download your pictures and videos 
from your Smartphone to your PC and vice versa. Thanks to its user-
friendly double-pane view, it allows quick and easy transfer.

Each pane contains tabs where your files are automatically stored 
according to their types (image, melody or video). Thus, it helps you 
with the exploration of your Smartphone.

Click the Mobile Explorer button , The Mobile Explorer 
window is displayed. Select the data you need transfer.
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Image Studio
Image Studio allows you to transfer an image from your computer to 
your Smartphone and use it as a wallpaper, a screensaver and/or send 
it to your friends. The image size and format are automatically 
adapted to the Smartphone screen. Using the Image Studio edition 
features, you can modify your image by adding borders or by 
cropping it.

Note: The availability of some features described in this manual 
depends on your software version.

Click on the Image Studio button to access Image Studio 
module.

Preview screen

Browser screen

Cropping screen
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The preview screen

The preview screen gives you a preview of the selected image as it 
appears on the screen of your Smartphone. Use the toolbar buttons to 
modify its appearance.

The browser screen

The Image Studio browser lets you select files stored on your 
computer in order to view, edit, and/or copy them to your 
Smartphone.

The cropping screen

Select an image in the Browser screen, then click the crop button . 
To modify the selected image using the toolbar button. The selected 
image is displayed in the preview screen as it will appear on the 
screen of your Smartphone.

Using the following button to edit your image:
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Melody Studio
Melody Studio allows you to select your favorite musical extracts, to 
use them as ring tones on your Smartphone.

Melody Studio converts your sound files and audio CD tracks to a 
format adapted to your Smartphone.

Using its edition features, you can extract a part of a music track, 
modify the tempo and set the fade in/fade out effects.

Click on the Melody Studio button to access Melody Studio 
module.

Information screen

Browser screen

Selection screen
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The information screen

The Information screen displays information about the selected 
melody to be copied to your Smartphone.

The browser screen

The browser lets you select sound files stored on your computer in 
order to play and/or copy them to your Smartphone.

Double-click on the desired sound file to play to melody file.

The selection screen

The Selection screen lets you preview and select the musical extracts 
you want to copy to your Smartphone.

Video Studio 
Video Studio helps you in creating and editing Smartphone movies. 

It assists you in adding texts and sounds to your clips easily. Using its 
numerous functions, you will be able to combine and split them, and 
change their order and duration, etc. Then, once your final movie is 
completed, Video Studio allows you to transfer it to your 
Smartphone.
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Click on the Video Studio button to access Video Studio 
module.

The media files selection screen

Using the selection screen to select the video clips or the files 
(containing the image, text, music track, or sound) you want to open 
for editing or to attach to the movie. Once the file is selected, you 
need drag and drop it onto the composer screen. When selected with a 
single click, the file content is automatically displayed in the preview 
screen.

File selection 
screen

Preview screen

Composer screen
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The composer screen

It allows you to link video clips (images or photographs), adjust the 
timing of each of them, and insert personal texts and/or audio 
recordings into each or all video clips. The composer screen can be 
displayed in two different modes: storyboard view or edit view.

The preview screen

The preview screen displays the selected item as it appears on the 
screen of your Smartphone.

You can also edit, copy, cut, transfer files in Video Studio.

Note: We only give the brief introduction for using Multimedia Stu-
dio in this manual, please refer to the Multimedia Studio Help 
in mobile PhoneTools for more details.
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Appendix

Traffic safety
Please check the laws and regulations on the use of mobile phones in the areas 
where you are driving. Always obey them. Please use a hands-free kit while 
driving.
Pull off the road and park before making or answering a call if driving conditions 
so require.
Always secure the phone in its holder. Do not place the phone on the passenger 
seat or where it can break loose in a collision or sudden stop.

Phone operating
Remember to follow any special regulations in force in any area and always 
switch off your phone whenever it is forbidden to use, or when it may cause 
interference or danger.
When connecting, read the User Guide for detailed safety instructions. Do not 
connect it to incompatible products.

Electronic devices
Most modern electronic equipment is shielded from radio frequency (RF) signals. 
However, certain electronic equipment may not be shielded against the RF 
signals from your wireless phone.

Persons with pacemaker
• Should always keep the phone more than 20cm (7.8 inches) from their 

pacemaker when the phone is switched on.
• Should not carry the phone in a breast pocket.

Safety
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• Should use the ear opposite the pacemaker to minimize the potential for 
interference.

• If you have any reason to suspect that interference is taking place, switch 
OFF your hand-held phone immediately.

Hearing aids
Some digital wireless phones may interfere with some hearing aids. In the event 
of such interference, you may want to consult your operator or network service 
provider.

Other medical devices
Operation of any radio transmitting equipment, including wireless phones, may 
interfere with the functionality of inadequately protected medical devices. 
Consult a physician or the manufacturer of the medical device to determine if 
they are adequately shielded from external RF signal or if you have any 
question.
Switch off your phone in health care facilities where regulations are posted to 
instruct you to do so. Hospitals or health care facilities may be using equipment 
that could be sensitive to external RF signal.

Vehicles
RF signals may affect improperly installed or inadequately shielded electronic 
systems in motor vehicles. Check with the manufacturer or its representative 
regarding your vehicle. You should also consult the manufacturer of any 
equipment that has been added to your vehicle.
Do not carry it with any combustible, explosive object. In such environment, it 
could cause an explosion or fire resulting in injury or even death.
An air bag inflates with great force. Do not place objects, including both installed 
or portable wireless equipment, in the area over the air bag or in the air bag 
deployment area. If in-vehicle wireless equipment is improperly installed and the 
air bag inflates, serious injury could result.



182

A
p

p
en

d
ix
Posted facilities
Turn your phone OFF in any facility where posted notices require you to do so.

Potentially explosive environment
Turn your phone OFF and do not remove the battery when in any area with 
potentially explosive environment and obey all signs and instructions. Sparks, 
from your battery, in such areas could cause an explosion or fire resulting in 
injury or even death.
Areas with a potentially explosive environment are often, but not always clearly 
marked. They include fueling areas such as gasoline stations; lower deck of 
boats; fuel or chemical transfer or storage facilities; areas where fuel odors are 
present, etc.
If a gas/propane leak occurs in a car or home; areas where the air contains 
chemicals or particles, such as grain, dust, or metal powders; and any other area 
where you would normally be advised to turn off your vehicle engine.

Aircraft
FCC regulations prohibit the use of your phone while in the air. Switch OFF your 
phone before boarding an aircraft.
To avoid interfering with the aircraft instrument, do not use the phone on the 
plane.
Persons who disregard the regulations could have their wireless device being 
confiscated, or being charged in court; OR both.
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This unit is a product of superior design and craftsmanship and should be treated 
with care. Please read the suggestions below carefully, which will help you enjoy 
the functions of the product and its accessories longer.

• Do not dispose of batteries in fire!
• Keep it and all its parts and accessories out of children’s reach.
• Keep it dry. Precipitation, humidity and liquids that contain minerals will 

corrode electronic circuits.
• Do not use or store it in dusty, dirty places, which may reduce the 

performance of the product and cause damage.
• Do not place it in hot places. High temperatures can shorten the life of 

electronic devices, damage batteries and warp or melt certain plastic parts.
• Do not attempt to open it. Non-professional handling of the device may 

cause damage to it or even invalidate the warranty.
• Do not drop, knock or shake it. Rough handling can reduce the lifetime of 

the unit or cause damage.
• Do not use strong detergents, chemicals or alcohol to clean it, or use dry 

cloth to wipe the screen. Please wipe it with soft and slightly dampened 
cloth or anti-static cloth.

• If the unit, battery, charger or any accessory is not working properly, take 
them to your nearest authorized and qualified service center. Non-
professional handling may cause great damage and invalidate the warranty.

Care and Maintenance



184

A
p

p
en

d
ix
The S20 Smartphone is a radio transmitter and receiver. It has been designed and 
manufactured to not exceed recommended international guidelines on limits for 
exposure to radio frequency (RF) energy.
These recommended limits are part of comprehensive guidelines from the 
International Commission on Non-Ionizing Radiation Protection to establish 
permitted RF energy levels for the protection of the general population and 
incorporates sufficient safety margins to ensure the safety of all, regardless of age 
and health conditions.
Specific Absorption Rate (SAR) is the accepted unit of the measure for exposure 
standards on mobile phones, and the limit stated in the international guideline is 
2.0W/kg averaged over 10g of tissue.
The highest tested SAR value for this model (S20) is 0.627W/kg over 10g of 
tissue.
Additional information on SAR is available at www.who.int/peh-emf.

For body worn operation this phone has been tested and meets (Federal 
Communications Commission) FCC RF exposure guidelines when used with an 
accessory that contains no metal and that positions the handset a minimum of 1.5 
cm from the body. Use of other accessories may not ensure compliance with FCC 
RF exposure guidelines.

SAR

FCC Statement
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